
Intro to ArcGIS Pro
Oklahoma State Training



Introductions

• DATAMARK Technologies
• Oklahoma GIS Committee Members
• Class Attendees



Agenda

Day 1 – Intro to ArcGIS Pro and Displaying Data
• ArcGIS Pro Overview – 1 hr
• Introduction to ArcGIS Pro – 3 hrs
• Introduction to Catalog – 1 hr
• Attribute Tables and Queries – 2 hrs
• Attribute Editing – 2 hrs

Day 2 - Editing and Data Management
• Symbology and Labeling – 2 hrs
• Geometry Editing – 3 hrs
• Advanced Editing Techniques – 1 hr
• Cartography and Map Creation– 1 hr
• Best Practices and Oklahoma NG9-1-1 GIS 

Toolkit Overview – 1 hr



ArcGIS Pro Overview
Module 1



What is GIS?
• A system that allows us to answer questions and make 

decisions that involve a ‘where’
• Where is it?
• How far away is it?
• What is near it?
• How do I get to it?
• Where is the best location to do X?

GIS is…
• A framework for gathering, managing, analyzing and 

displaying data that has a geographical or spatial 
component

• An integration of hardware, software, data and people

But first…



What is ArcGIS Pro?
• ArcGIS Pro is Esri’s modern desktop GIS application designed for mapping, 

spatial analysis, and data visualization. It offers a streamlined interface, 64-bit 
performance, and integration with ArcGIS Online for sharing and 
collaboration

• Part of the ArcGIS platform, integrates with ArcGIS Online and Enterprise for 
cloud-based workflows, and for sharing and collaboration

Key Benefits
• High Performance: Optimized for large datasets and complex analysis
• Scalable: Works for individuals, teams, and enterprise-level deployments
• Interoperability: Connects with other Esri products and external data sources

ArcGIS Pro Overview



What is a Pro Project?
• A Pro Project organizes all your maps, layouts, data 

connections, and tools in one workspace. Creating a 
project ensures consistency and enables easier 
resource management. When created, projects 
typically include a default geodatabase and toolbox for 
storing data and workflows.

Creating a Pro Project



Storage Options
• File Geodatabase: Local, single-user, efficient for analysis
• Enterprise Geodatabase: Multi-user, versioning, collaboration
• Cloud Services: ArcGIS Online for sharing and scalability

Choosing the Right Storage
• Consider data size, editing needs, and collaboration
• Local projects → File Geodatabase
• Enterprise workflows → Enterprise Geodatabase
• Distributed teams → Cloud-based storage

Class Exercise 1

Data Storage in ArcGIS Pro



Map Interface
Module 2



• ArcGIS Pro is designed with a ribbon-based interface for intuitive navigation and 
productivity

• Ribbon Interface: Located at the top of the application, organized into tabs
• Key Tabs:

• Map: Tools for navigation, adding layers, and managing map views
• Insert: Add new maps, layouts, and data frames
• Analysis: Access geoprocessing tools and spatial analysis functions
• View: Manage panes, windows, and multiple map views
• Contextual Tabs: Appear based on selected items (e.g., layer-specific tools)

Exploring Ribbons



The Map tab is the primary ribbon for interacting with maps in ArcGIS Pro. It contains groups of 
tools organized by functionality:

Map Ribbon

1. Navigate Group
• Explore: Pan, zoom, and identify features in the map.
• Bookmarks: Save and manage map extents for quick navigation
• Full Extent / Previous / Next Extent: Quickly adjust the map view
2. Layer Group
• Add Data: Import layers from local files, databases, or ArcGIS Online.
• Basemap: Choose from predefined basemaps (e.g., imagery, streets).
• Add Preset Layer: Quickly add common layers like elevation or imagery.
3. Selection Group
• Select: Choose features interactively.
• Clear Selection: Remove all selected features.
• Select by Attributes / Location: Advanced selection using queries.

4. Inquiry Group

• Measure: Calculate distances, areas, and feature lengths.
• Locate: Search for addresses, coordinates, or places.
• Coordinate Conversion: Convert between coordinate formats.
5. Labeling Group
• Provides tools to manage and customize how labels appear on your map. 
• Labels are dynamic text derived from feature attributes, helping users 

interpret spatial data effectively.



The Insert tab is the primary ribbon adding new elements to your project, such as new maps, 
scenes, and layouts.

Insert Ribbon

1. Project - Create or manage project templates
• Functionality: 

• Allows you to start new projects based on predefined templates 
• Templates can include maps, layouts, styles, and connections to data sources
• Useful for maintaining consistency across multiple projects

2. Knowledge Graph - Integrate and analyze complex relationships between entities.
3. Layer Templates - Quickly add preconfigured layers to your map

• Functionality: 
• Provides a gallery of layer templates (e.g., Map Notes, Bright Notes)
• Templates include predefined symbology and settings for common tasks
• Speeds up map creation by avoiding manual configuration



Insert Ribbon

4. Link Analysis - Inserts tools for analyzing relationships between features. Helps visualize and quantify connections 
(links) between entities in a network.
5. Measurements - Adds measurement tools to your map or layout. Allows you to measure distance, area, and location 
coordinates interactively.
6. Styles - Insert or manage styles for symbology and design. Styles include color schemes, symbols, and fonts for 
consistent cartographic design.
7. Favorites - Provides quick access to favorite items you’ve marked. Favorites can include layers, templates, styles, or 
other frequently used resources. Speeds up workflow by avoiding repeated searches for commonly used items.



The Edit tab provides all the commands needed for creating and modifying spatial data.

Edit Ribbon

1. Clipboard – Handles copying and pasting features. Quickly duplicate or move features between layers or maps.
2. Manage Edits – Controls editing environment and settings. 

• Note: There’s no manual “start/stop” edit session—editing begins automatically when you modify data and 
ends when you save or discard edits.

3. Snapping – Ensures precise alignment of features during editing. Prevents gaps or overlaps by snapping vertices to 
other features within a specified distance.

4. Features – Create, modify, and manage features templates. Opens pane with templates for feature creation and 
contains the full collection of tools for editing existing features.

5. Selection - Controls how you select features for editing and allows you to isolate features within map. Opens 
Attributes pane for selected features to perform attribute edits.

6. Tools – Provides a quick access to the editing tools. (On Day 2 we will explore many of these editing tools!)
Class Exercise 2



Introduction to Catalog
Module 3



• Catalog is a central location for managing GIS data in ArcGIS Pro
• Provides access to maps, layers, databases, and tools
• Organizes resources for efficient project management

Catalog



• Catalog can be accessed through the ‘View’ ribbon and can be 
opened as Catalog View (full screen view of Catalog – below 
image) or Catalog Pane (docked window for quick access – 
right image)

• Expand folders and databases to locate data
• Search functionality helps find specific resources quickly

Navigating Catalog



• Preview spatial and tabular data in the Catalog pane
• Check attribute tables and geometry before adding to map
• Supports multiple formats like shapefiles, geodatabases, and rasters
• Drag and drop data from Catalog into the map view

• Use 'Add Data' button for precise selection
• Ensure coordinate systems match for proper alignment

Viewing and Adding Data in Catalog



Metadata
• Metadata describes the content, quality, and lineage of data

• Edit metadata in Catalog by right clicking the layer and selecting ‘Edit 
Metadata’



• Import tables, shapefiles, and data into geodatabase
• Export layers to different formats for sharing
• Use geoprocessing tools for batch operations

Class Exercise 3

Importing and Exporting Data



Exploring Attribute Tables
Module 4



• Information that relates to a spatial feature in a dataset
• Maps are just a picture!
• GIS links maps and data

Attributes



Attribute Tables
• The attribute table is a view of the database that stores descriptive information about 

geographic features in each layer or table

• Each record represents a single feature, and each field represents a specific attribute 

• Attribute tables show the fields for a layer and show feature selections

• Features can be created, updated, or deleted from the Attributes Table or the Attributes Pane



Queries
Module 5



Attribute  Queries
Attribute queries in ArcGIS Pro are operations that allow you to select, 
analyze, or manipulate table records based on their attributes.

Instead of asking “What features are within a mile of this city?” (a 
spatial query), an attribute query asks questions like:
• Which values in this field are null?
• Are their field values greater than 100?
• Are the values of Field A the same as those of Field B
Key Characteristics:
• Uses Structured Query Language (SQL) as a tool to investigate values 

in a given table
• Queries relate to one table (or feature class) at a time
• In ArcGIS Pro, there is a robust Expression Builder that makes it 

easier to create, test, and reuse attribute queries
• Multiple selection types including: Subset selection, Remove from 

selection, and Add to selection. These queries can be combined with 
manual feature selection or spatial selections



Spatial Queries
Spatial queries in ArcGIS Pro are operations that allow you to select, 
analyze, or manipulate geographic features based on their spatial 
relationships rather than just attribute data. 

Instead of asking “What features have a population greater than 
10,000?” (an attribute query), a spatial query asks questions like:
• Which features intersect this polygon?
• What points are within 500 meters of this line?
• Which parcels are completely contained within a city boundary?
Key Characteristics:
• Uses geometry relationships such as intersect, within, contains, 

touches, crosses, or overlaps
• Often combined with attribute queries for more complex analysis
• Common tools include Select by Location, Spatial Join, and Overlay 

Analysis
• Spatial queries are essential for tasks like proximity analysis, finding 

overlapping areas, or determining spatial patterns in GIS workflows
Class Exercises 4, 5, and 6



Day 2



Symbology and Labeling
Module 6



Symbology
Refers to the way geographic features are visually 
represented on a map. Determines how points, lines, 
polygons, and raster data appear, using symbols, colors, 
patterns, and sizes to convey meaning.

Symbology basics:

• Symbols: Graphic representations for features (e.g., icons 
for points, line styles, fill patterns)

• Color and Size: Used to show categories, quantities, or 
relationships

• Transparency: Controls visibility and layering

• Labeling and Text: Adds descriptive information to 
features

• Rendering Methods: Includes single symbol, unique 
values, graduated colors, proportional symbols, and more!



Symbology
• Symbology within ArcGIS Pro can be accessed through the Feature 

Layer ribbon of a selected feature class
• The Symbology pane will appear with the options to adjust the 

layer’s symbology
• Select the symbol image to open the Gallery and Properties 

options which allow you to adjust the color, size, shape, and more
• Save customized symbology to be a part of your “Favorites” for 

quick access in the future



Labeling
• The process of automatically placing text on a map to describe features, 

such as names of roads, addresses, cities, or other attributes from your 
data.

• Labels are generated dynamically based on feature attributes and 
placement rules. They update automatically when the map scale or 
extent changes.



• Labeling can be accessed in the Ribbon 
when the layer is selected in the 
Contents pane or by right clicking the 
feature class and selecting Labeling 
Properties

• Expressions can be written in Arcade, 
Python, or VBScript

• Allows multiple label classes and scale – 
dependent visibility

Labeling in ArcGIS Pro



Labeling Syntax
Expressions can be written in Arcade, Python, or VBScript
VBScript
• Field delimiters: Field names are enclosed in square brackets [FIELDNAME]
• Concatenation: The ampersand (&) operator is used to join strings, fields, and text. Text will use double quotes (“) to surround 

the values.
• Example: [FIELD1] & " " & [FIELD2]

• Line breaks: Must use & vbnewline &

Python
• Field delimiters: Field names are enclosed in square brackets [FIELDNAME]
• Concatenation: The plus sign (+) operator is used to join strings, fields, and text. Text will use double quotes (“) or single quotes 

(‘) to surround the values.
• Example: [FIELD1] + ‘ ‘ + [FIELD2]

• Line breaks: Must use + ‘\n’ +

Arcade
• Field delimiters: Field names are formatted as $feature.NAME
• Concatenation: The plus sign (+) operator is used to join strings, fields, and text. Text will use double quotes (“) or single quotes 

(‘) to surround the values.
• Example: $feature.NAME + " - " + $feature.TYPE
• Line breaks: Must use + TextFormatting.NewLine +

Class Exercise 7



Data Editing
Modules 7 



Editing
• Editing is when you create, update, or delete a feature’s geometry or attributes

• Editing occurs in an edit session, but in ArcGIS Pro, an edit session is started by 
default when you open a project

• Editing a feature’s geometry happens when you place or move the vertices that 
represent a feature’s spatial geometry

• Editing a feature’s attributes happens when you type or calculate new field values for 
one or more features using the Attributes Table or Attributes Pane



• Functions such as creating features, saving edits, 
selections, and all editing tools can be found within the 
Edit Ribbon

• Enable Snapping to support topologically accurate editing
• Expand the Tools section to view the tool gallery
• Customize the tool gallery to add commonly used tools 

within your Favorites
• Utilize the Search bar when looking for a tool

Edit Tools



Cartography and Map Creation
Module 8



• Cartography is the art and science of making maps
• It involves the study and practice of representing geographic 

information visually, using symbols, colors, and design principles to 
communicate spatial relationships effectively.

• Maps tell a story to the reader
• There are some etiquette basics of cartography:

• Colors automatically tell the reader information about the feature
• Ex: Blue = water features, “cooler”/“less” metrics

• Size matters! The larger the size given to a feature or label, the more important 
you’re telling your reader it is

• Labels and feature placement can also tell the reader what is most important on 
your map

Cartography



• Layout Views are the workspace to design a 
digital or paper map using the GIS data

• Layout Views contain one or more map frames 
based on the maps in your Project and 
cartographical objects such as a Legend and 
North Arrow

• Layout views update in real-time based on 
how you change the GIS data or its symbology 
and labeling in your Project map

Layout Views



Map Creation
Add Your Map Frame 

• In the layout view, click Insert → Map Frame
• Select the map you created earlier and draw the frame 

on the layout in the layout space
Add Map Elements

• In the layout view, click select element to add to frame
• Draw a box within the map frame to place element
• Right click the placed element to open element 

properties to further adjust the details of the contents
Additional Notes

• Map frame is dynamic, as you move the location of the 
map in your Map tab, it will adjust the visual display of 
your Layout frame

• Map frame can be adjusted from Layout view if map is 
activated. Right click and active frame to pan and select 
within the map



Best Practices for QA/QC
& Oklahoma NG9-1-1 GIS Toolkit 
Overview



Creating a Quality Assurance (QA) Culture
• QA enforces those best practices

• Stakeholder engagement

• Business needs for data - who 
manages

• NG9-1-1 Education

• Improving existing workflows

• Iterative validations on NG9-1-1 data

• NOT a one and done

• Scheduled - may need more 
frequently if increased editing and 
adding data



• Maintain required fields within data
• Be mindful of how other features impact data attributes
• Address point within road range - ranges may require adjusting when address 

points are added or removed
• Breaking road centerlines at boundaries and updating attributes appropriately
• Parse address elements
• Standardize attributes
• Leverage domains to reduce inconsistencies and errors
• Avoid blank values in data and replace with NULL

Best Practices



• Use the Command Search!
• Use Field Calculator “helpers” to perform quick updates
• Save your feature symbology to be used in the future without having to configure
• Import Symbology from other layers
• Drag and drop folders from File Explorer directly into the Catalog Pane to quickly 

make folder connections
• Utilize the Quick Access Toolbar for all your favorites
• Instead of searching in the ribbons, right click the map to activate “Select Features” 

tool, “Explore cursor” tool, and others
• When editing vertices, press the keyboard space bar to temporarily turn off snapping 

while editing
• Use the Attribute window to edit fields with domains

Tips and Tricks in ArcGIS Pro



• Newest version of the OK Toolkit has been released and can 
be downloaded from the GIC site: 
https://www.okmaps.onenet.net/address_standards.htm

• OK Toolkit v3 is built for ArcGIS Pro and uses the newest 
NG9-1-1 and Address Standard Schema

• Layout of the toolkit categories and tools have been 
condensed and simplified from previous versions

• The OK toolkit must be incorporated in your QA/QC process 
and data will be required to be submitted to the OK 
Repository on a quarterly basis

Upcoming trainings to be announced in the coming months!

Oklahoma NG9-1-1 GIS Toolkit v3
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